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Introduction

Why do we perform model checking?
Make sure that we get correct and consistent results.
Save time.

This webinar aims to do the following

Recommend a good practice by which the number of errors from start to finish in the
project are minimized.

Give an overview of the current model checking tools that exist in the softwares that we
provide.

Point at some simulation/modelling errors that are not found by the model checkers.
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Reference

analyses using LS-DYNA

fovna

Technical Guide

models for explicit

ested modelling structure

Main.k

*INCLUDE
*CONTACT
*LOAD
*BOUNDARY

*CONTROL_ACCURACY
*CONTROL_BULK_VISCOSITY
*CONTROL_CONTACT

*CONTROL_ENERGY

*CONTROL_HOURGLASS

*CONTROL_OUTPUT
*CONTROL_SHELL
*CONTROL_SOLID

*CONTROL_SOLUTION

*DATABASE._...

Database cards.k

*DATABASE_BINARY_D3PLOT
*DATABASE_BINARY_INTFOR

Materials.k

*MAT

*DATABASE_EXTENT_BINARY
*DATABASE_HISTORY...

Rarely changed =

* Few errors are introduced.

+ All normal results are always available.

* Prepared settings for different types of analyses.

Geometry.k

*NODE
*ELEMENT...
*PART
*SECTION...
*SET_NODE
*SET_ELEMENT
*SET_PART

.
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Loading your model in preprocessor

When your model is loaded in a preprocessor, some basic checks are
performed.

Wrong formatting of keywords
Unrecognized keywords

Duplicate keywords, nodes, elements, etc.
Include files not found

Node set not found

TAB character exist in keyword

Read all these messages and take necessary actions.

Note! Encrypted files can not be read by any preprocessor. Therefore, this
input data can not be checked either.
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Tools for checking your model

Different types of checkers (pre and post) are available in:
LS-PrePost
Primer
Ansa
DYNAtools

Many of the checking options are similar in LS-PrePost, Primer and Ansa

Different tools could indicate different problems, e.g. different contact
checkers can show different initial penetrations. Which one is correct then?

The answer is always: LS-DYNA. Updates/improvements on for instance contact treatment
will cause the behavior to change between LS-DYNA versions. Model checkers in general
don’t care which LS-DYNA version you are running.
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Model checker in LS-PrePost

Accessed through the “Application” menu.

Use late version for support of newer keywords. Current production version is
4.7 (development 4.8).

[ LS-PrePost(R) V4.6.18 - 205ep2019 Model Checking %
File Misc. View Geometry FEM @ Application Settings Help
ﬁ Occupant Safety > Element Quality Keyword Check Contact Check Model Check Setting
— ) Beam Solid
&t Metal Forming 4 @ Shel Tshell
Q; Model Checking > ‘}j General Checking Checking method
5 B uality Check S
5. Tools > ALE Checking Duplicate
A ‘m Mormal
ﬁ Crash Safety 5 Free - Unattached
UnderCut
Curvature
>
‘ NVH Gaussian Curvature v
k
m ALE Setup Shell check item Allowable Min. val Max. val #violated(%)
&% Granular Flow Setup [IMin side len 3 R R o L
l%® 30Graph [IMax side len o o -
. Cust . D Aspect ratio gk gk ek
ustomize
b |:|Warpage FEE FEE ek
j’g Segment Pressure Wave CIMin quad ang e e e
& BatteryPackaging [IMax quad ang P P ke
' Wear I Min tria ang o o wER
DMax tna ang EE s EE s EE s
DTEDEI’ EE s EE s EE s
L B ar e e e e e e N
4] Frin
Clear Save Failed Delete Failed Report
Fringe
Solid Rev Save Failed
Done
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Model checker - element quality

Element quality may refer to many different things
Element shape
Element type

Connectivity of elements
Duplicate nodes?
Beams or shells connected to solids by sharing nodes?
Tied contacts for connecting parts, what about the rotational degrees of freedom?

Element shape can be checked by the model checker
Element type is recommended in DYNAmore Nordic guidelines

Connectivity can be checked by
Duplicate nodes in LS-PrePost.
Tied contact checker in LS-PrePost.
Eigenvalue analysis.
Primer or Ansa.

Time Step
1.939e-06
1.799e-06 :I
1.660e-06 _|
1.520e-06 _
1.380e-06 _
1.241e-06 _
1.101e-06 _
9.615€-07 _
8.219e-07
6.823e-07 :I
5.427e-07
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Keyword checker

Lists potential problems for all keywords in the model.

Possible meaning:

Meodel Checking

Elernent Quality Keyword Check

Contact CHeck Model Check Setting

Error: Critical mistake that probably

Total

#-BOUNDARY(6)
& CONSTRAINED(3)
- CONTACT(3)
- CONTROL(15)
- DATABASE(20)
- DEFINE(E)

- ELEMENT(24369)
- KEVWORD(1)

- MAT(E)

- NODE(96298)

- PARAMETER{1)
- PART(10)
#-SECTION()
-SET(3)
&-TITLE(T)

Error{(]

Error(0)

Error{0)
Error(0)
Error(]

Warning(3) || UnRef(11342) || UnDefined(1)
Warning(1) |fJnRef(0) UnDefined(1)
rning(0) |[UnRef(0) UnDefined(0)
ing(0) ||InRef(0) UnDefined(0)
UnRef(0) UnDefined(0)
arning(0) |InRef(0) UnDefined(0)
UnRef(1) UnDefined(0)
g0} |nRef(0) UnDefined((]
g(0) ||UnRef(0) UnDefined (0
g0} |nRef(0) UnDefined((]
g(0) |WnRef(11940) || UnDefined(
g(0) ||InRef(0) UnDefined (0
rning(0) |[UnRef(0) UnDefined((]
ing(0) |JUnRef(0) UnDefined (0
arning (0] | UnRef(1) UnDefined (0]
arning(0) |InRef(0) UnDefined(0)

needs to be fixed.

Warning: Settings deviate from normal

Do not Check Contact

or default settings.

Unreferenced: Keyword not used in the
current model.

Undefined: Missing entity in model, e.g.

Recheck Model Clean Yrite

referenced curve.

Snap |

Done

Note: A missing entity could be present in an encrypted include file.
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Contact checker - penetration definitions

Edge-to-edge penetration

Crossed edges Node-to-edge penetration

y

Node-to-surface penetration

IbOhvnna
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Contact checker

Contacts may be checked one at a time or all at once.

Tied contact may also be checked, showing which nodes that are tied and
which are not.

ByParts: Contact is checked without having to define contacts. The intention
is to look for geometrical overlaps. The check fakes a single surface contact
check (with SSTHK=0) and considers:

Thicknesses (taken from section cards). Mol Shecine 8
. Elerment Quality Keyword Check Contact Check Model Check Setting
Node-to-surface penetrations. @Penet O Ted
. (C) ByParts (@) Conta
Free_ed ge- to- Free_ed ge penetrat'lons . 1(15000001) AUTOMATIC_SURFACE_TO_SBEEF:CE_MZR'IT':A(:PSET 111 PART 1 (sub:1) Pusher to Cab

2(19000111) AUTOMATIC_SINGLE_SURFACE_MORTAR PSET 111 ALL 0 (sub:1) Cab internal contact

Node-to-edge penetrations.
Contact: This check also considers:

Show: [#]CE [~ Penet Slave Master Both [JRefParts

Parameters related to contact thicknesses. S+ T 10

(SST, MST, SFST, SFMT, SHLTHK, SLDTHK, SSTHK, OPTT, SFT, TH, TH_SF...) | qgnare <

Which entities that may come into contact. o
Move 100 % of penet
Run 4 | iterations
Manual Fixing
Flip Mode Undo
Check Fix Undo Write
Done
rlDY N A Webinar - Model checking in LS-DYNA, Copyright ©2020 DYNAmore Nordic AB. All rights reserved. 2020-04-16 12
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Model check setting

Values for the checker can be set, saved and loaded.

Meodel Checking

General:

BeamFix

ALE:

Gen thick:
Fabric thick:
Beamn thick:
CT(BSORT):

CT(SFS):
CT(SFM):
3Node Ang:
Spot min len:
Spot max len:
CR(DTMIN):
DE_CURVE(a1):
DE_CURVE(o1):
DE_CURVE(pt):
MA_SW(SIGY):

CR_ALE(AFAC):
CR_ALE(WF):
CR_TIMESTEP:

0.5

0.25

1000

1.1

HNHIIE

Element Quality Keyword Check Contact Check Model Check Setting

Element Quality:

Shell:
Min Len: Max Len:
MinT Ang: MaxT Ang: 120
Jacob: Chr Len:
Solid/ Tshel:
Min Ang: Max Ang: 175
Distortion: Chr len: l:l

_ADDW Savepre Loadpre

Dane

IbOhvnna
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What does LS-DYNA say? / d3hsp viewer

Search for Warnings/Errors in all message files and d3hsp.

| have seen own scripts being used for:
= fringing contact penetrations
= creating sets of entities with problems for display purposes

With d3hsp viewer in LS-PrePost
= Different parts of the d3hsp file is available in groups
= Easier to scroll through content and look at all Warnings
= Highlight things on the model that are problems (blue text only)

E D3hsp View oaEs

Search: | warning @@= | merstar | i e

Implicit Statistics: Dynamics

#% Warning 50136 (MPP+136)
% Warning 50136 (MPP+136) [ plot as function of time [net/vis3/disk/local/338978.raven-dyna.in.dynamol
#%£% Warning 50136 (MPP+136) SR

*++ Waming 50136 (MPP+136) : - :
*x% \Warning 50136 (MPP+136)

*+ Warning 50136 (MPP+136)
o

is not constrained

since it is too far from segment. [_] Disp Norm [_J Energy Norm [_] RNORM-absolute
tied interface # = 7 R (4 Cur Step si e (et
iM-relative ur Step Size onverge lterations
slave node # = 268195 2 <
segment # = 410 [ stiffness Reformations [_| Calculate time per step [_] Num RHSE
distance from segment = 1.0000E-+01 .
Num LSCiter |_| Retries
segment nodes: I
271806 1661 1660 271807 2
Plot Plot New | Plot Add Save TabForm Pop Animate
» % Warning 50136 (MPP+136)
b *%% \Warning 50136 (MPP+136)
Display Refered Entity:
(¥ Display Entity All None
file Path: | jnetjvis3/disk/local/338978.raven-dyna.in.dynamc  Browse
Load Remove
Expandall || Collapseall || save2xmL Done

rlDY NI A\ Webinar - Model checking in LS-DYNA, Copyright ©2020 DYNAmore Nordic AB. All rights reserved.  2020-04-16
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What to check for in post-processing

Mass increase
Available as “added mass” in *DATABASE_GLSTAT.

Energy balance and strange energies
Switch on output of all energies on “*CONTROL_ENERGY, e.g. set HGEN=2 (not default).

Ekin + Eint + Esi + Erw + Edamp + Ehg = El(c)in + Eiglt + Wext

Etotal
Eyin = current kinetic energy
Eint = current internal energy
E; = current sliding interface energy (including friction)
E-w = current rigid wall energy
Egamp = current damping energy
Eng = current hourglass energy
ER.. = initial kinetic energy
ED, = initial internal energy
Wt = external work

rl)Y N A Webinar - Model checking in LS-DYNA, Copyright ©2020 DYNAmore Nordic AB. All rights reserved.  2020-04-16
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Energy balance in example model

Successful implicit ROPS simulation (lateral loading).

ROPS simulation

Glstat Components
60 _ - -A external_work
~~ | _B _hourglass_energy
L C internal_energy
D kinetic_energy
50 _E sliding_interface_energy
| / F total_energy
@
H 40
E
— 30
>
o i ,9/
e
Q /
£ 20 /
10 /
0E- 8" B B E | B E p  E
0 0.1 0.2 0.3 0.4
Time
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Ansa model check

E ANSA v20.1.0 64-bit (/disk/work/davida/d3hsp_viewer/ROPS/Error_model/te

File Tools Utilities Lists Assembly Plugins Windows Help

Database 3] & @

. Current Pa rigid body

v | Name : Number  Visible
ANSAPART
ASSIGN_VAL_TO_FIELD
A_PARAMETERS
BOUNDARY
CONSTRAINED
CONTACT

CONTROL

DATABASE

DEFINE

EDGE

ELEMENT 84369 84369
GEOMETRY 3 o
MATERIAL 6

NODE 96298
PROPERTY 10

SET 3

<

®

<

B checks Manaéer: 14 templates were loaded from ’Idlsk/sw/BETA/EETA:CAE:S}stenZ
Checks Manager: 14 templates were loaded from '/disk/sw/BETA/BETA_CAE_Systen—
v

= \ oz -

Info

Run model integrity
checks, providing
automatic error fix
options.

ul &p e ap =l

-IER O

General checks

—

LS-DYNA specific checks

Auxiliaries

Common Nodes
Connections
Connectivity

Duplicate Elements
Duplicate Set Names
Flanges Weld Spots
Free 4
Frozen Entities

GEB Status

Geometry
IDs-Mumbering Rules
Kinetics

Laminate Mapped Data
Length

Massless Nodes
Material Theta

Materials

Mesh »
Model Data

Multiple BCs

Penetration *

Range Check

Range Of IDs Within Includes
Unconnected Cross Section Flanges
Undefined

Rigid Bodies

Seat Belts

Solids

Solver Qutput

Spot Welds

Tables

Thick Shell Orientation
Unconnected Regions

Unigue Definition Entities

IbOhvnna
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Cohesive Orientation

Contacts »
Curves L
DB Cross Sections *
DB Histories

Extra Nodes Connectivity

Includes »
Initial Conditions-Integration Points
Initial Velocity

Joints

Mass Scale Ratio

Webinar - Model checking in LS-DYNA, Copyright ©2020 DYNArwortherﬂai@erBceAlleﬁglats reserved.
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Ansa Checks manager

A group of selected checks can be performed simultaneously, a suggestion of
LS-DYNA checks is prepared.

ecks Manager (/disk/sw/BETA/BETA_CAE_Syste

& Templates LS-DYNA Checks Edit Template l [ = Results l

Active | Name Execute on | Status EE]L
LT Massless All Entities
Multiple BCs All Entities
Undefined Materials All Entities
Undefined Properties All Entities
+T Constraint Rigid Body PIDM - PIDS distance all Entities -
LT Constraint Rigid Bodies Long Chain All Entities
4T Contacts All Entities
L= Curves:Axes All Entities
¢/l &* Curves:End Time All Entities
(] DB Histories All Entities Ea
‘\ [total 19 [selected 0|

\
Cececne || \ |
Name Walue x EE]

Mesh: Incomplete All Entities
|+ Initial Velocity All Entities
4 Joints All Entities
¥ & Mass Scale Ratio All Entities

Rigid Dependency LS-Dyna All Entities

SPCs on Rigid Body Nodes All Entities

T Spot Welds All Entities

Tables All Entities

Unconnected Regions:Rigids All Entities

. Check Summary
Parameters List

rDY N A Webinar - Modg
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Selection of Ansa model checks (Chapter 21 in Ansa manual)

Check > Connectivity - Detect unconnected assemblies

Rigid bodies in LS-DYNA (more info on next slide)

Check contacts from solver (only for tied contacts so far)

Unconnected regions (same property but disjoint volumes) - RIGID BODIES!

Joint check

Are nodes rigid/deformable? Do nodes of joint belong to the correct parts or perhaps
several parts? Do the nodes coincide? Perpendicularity/colinearity of vectors defined by
the nodes (depends on joint type)?

Constrained extra nodes check (too far from rigid body?)
Database cross section check
PIDM-PIDS distance (constrained rigid bodies distance too long?)

rlDY N A Webinar - Model checking in LS-DYNA, Copyright ©2020 DYNAmore Nordic AB. All rights reserved.  2020-04-16 19
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Ansa model check - rigid bodies in LS-DYNA

Node belonging to two or more different parts.

Node belonging to two or more different nodal rigid bodies.

Node belonging to a rigid part and a nodal constraint set.

Node belonging to two or more different constrained extra nodes.

Node having the same degree of freedom constrained in more than one set.
Node belonging to a constrained extra node and a rigid part.

Node belonging to a constrained extra node and a nodal constraint set.

Collapsed nodal rigid bodies (or nodal constraint sets generally), initially
created on sets of nodes that belonged to a part which has been deleted.

*CONSTRAINED_EXTRA_NODEs, *LOAD_RIGID_BODYs or
*CONSTRAINED_RIGID_BODIESs that are associated with deformable part.

Seatbelt accelerometers, retractors and sliprings that are connected to
deformable elements.

Boundary Prescribed Rigid Motion that is associated with deformable part.
“Slave” rigid bodies with more than one "master”.

rlDY N A Webinar - Model checking in LS-DYNA, Copyright ©2020 DYNAmore Nordic AB. All rights reserved. 2020-04-16
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Primer model checker

To run: Check -> Options -> Check Categories -> Apply

= PRIMER 16.0 - 64 bit (build 24451), Licensed to : DYNAmore Nordic

JH# R Kopwords  Tools  Displap  mages Uewing  Options  Help Bk T PART (any type) ¥ | evin: [FFET Undo

CHECK OPTIONS |=jJE

Select checking categary

FPRIMER: I h i

Category: LE[uaIity ~
ChECHORMONS [ - T Elernent quality: ALL ON/OFF: nia

Check for free 1 [ elemn nodes: J

¢ Min ength: ]
| Select checking categary ax aspect ratio: J
Category: |Elua|ity ~ Mo warpage: J
Cluality ey Mat shew: J
Spatweld J Tria angle Min: Mz J
:i;li:de J Quad angle kin: has: J
Timestep \ J Min Jacobian: J
Added mass \ J Jacokiah caleulation method: GALSS POIMNTS ™
Tria ang Contact \ J Maz Taper: J
Quad ang ~oints J Min Tetra Collapse: J
;A;r:erlals J Ignare rull elements: |7
Jan Other E Tl Chieck skew of Tet elems: J

Feport rigid 10 elern with free end: o

Figport 10 elem only It both nodes free:

CHEC K OPTIQNS [ |
-
10,0 % elems fall quality

| Gelect checking catedory
arts with minimurn of 1 elems J

Category: |Higid T

Continuity of rigid parts with numel »= 2 J Model quality: ALL ON/OFF: hfa
Report duplicated elements: J

Optional continuity size check: <off:
Rigid body merge max separation:  100.0 J Count elements in different part as duplicate:

Modal rigid body max size: 1000 J imum 0.0 % frias allowed in shell parts: J

dinimum mazs for rigid part: ing factars:

Pinirmun mass for Mozl Rigid Body: Length:

Mo warn 'unused’ nrbfexno 15t node: J Warpage:

K
[ 0|

Wit angle: _ Max angle: _
[ 00 | [ 00|
[ 00|

Modal rigid body release flag check: J

Jacabian:

Tet Collapse:

3

AIRBAG
e

ASSIGH MASS
PSS [ #EOUNDARY

C4SE

COMMENT

COMPOSITE LAYUP

COMPOSITE PLY

CONMECTION

#CONSTRAINED

#CONTACT

| [~CONTROL

§ DamPING
[s#DaTEEASE

4 DEF_TO_RIGID
[wrDEFINE

DUMMY

| [w#ELEMENT

EOS

FATIGLE

FREQUENCY

GEOMETRY
[wGROUF

HOURGLAS S
[swNCLUDE FILE
INITIAL
INTEGRATION
INTERFACE
LOAD

Rules

Fasttef |

Dashboard Check |

Check model 1

Check model!

Check Categories r

[~ ATERIAL
S MECH&MISM
MORPH
wMODE
wFARAMETER
wFERT
PARTICLE
PERTURBATION
FslL
RIGIDWSLL
[ sECTION
SENSOR
[wsET

TERMIMATION

LUSER

Check &)l Categories |

Check Mo Categories

Custom Preference Filg

=]

g
e | I

Reset Primer Preferences

Open Errar Configuration File

IbOhvnna
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Primer model checker - results

Results are presented in a tree-structure.

PRIMER 16.0 - 64 bit (build 24451), Licensed to :

DYNAmore Nordic

i

JH% Fe Kepwords Tooks Disply Images Vewing Options Help Blnk T PART (any type) ¥ | kepin: [FP E] | Undo

M1

W T ee—

Ermor free viewer

1= %]

Recheck m -=item mode list M include ?

etch  Blank  Unblank  Only He:heckaﬁe:ted:ategomesr

EIERROR [4]
_MOTION [1]
[E1BPRM: Loadcurve <Icid= referenced but not defined (1)
5 (M1/BPRMS)
EICONTACT 2]
[EIF Constrained TIED/SPOTWELD contact containg rigid part(s) (1)
4 (Tied contact hack plate to frame)
[E10pt card & <5BOPT= only valid <50FT= =2
4 (Tied contact hack plate to frame)
13000001 {Pusher to Cah)
13000003 (Tied contact)
14000111 {Cab internal contact)
EIDEFINE_CURVE [1]
=IDEFINE_CURVE referenced hut not defined (1)
1/LC1005)

“)

EIWARNING [5]

1
[EIF Unexpected nan zero «<3BOPT= when SOFT.ne.2 : Set parameter SBOPT to 0 on contact (4)
4 (Tied contact back plate to frame)

13000001 {Pusher to Cah)

= GHEGK DVNASD MODEL

]
[

Chck (motiel 1)

Grand Totals 7 11945 7

Entity type (No.y  #erors  wwam  #fbxeble
BOUNDARY [
CONSTRAINED 3
CONTACT

CONTROL

DATABASE

DEFINE

ELEMENT

GROUP

INCLUDE FILE
MATERIAL

NODE

FARAMETER

FART

SECTION

SET

14000003 (Tied contact)
13000111 {Cab intemnal contact)
SICONTROL [1]
)0mitting populated data field <ncdcfs fram *CON
M1/CONTROL_SOLUTION
EINODE [2]
FHhade has no structural cross references (can he
[EF Constrained extra node is massless : Delete N
3713720 (M1/N3T13720)

and/or integrity.

Errors usually indicate a model that will not
initialize within LS-DYNA or will be of poor quality.
Warnings are indications of bad modelling practice

3713721 (M1/M3T13721)
EIPART 1]
[=IPrescribed mation X on rigid part (t=0) but missing node initial velacity (1)
1 (Load distributing device)

| i oA [ i a3

[ otor | mmm EN
Ticy | vews | Fev ]
== Ent |

T overs TN et |

DWNA Dutpull Elem Qual ‘ Dashboard Check |

[ Check motlel 1

Check model: |

o

Check Categaries -

Custom Preference File

Read

Reset Primer Preferences

]
m]

Open Errar Configuration File

IbOhvnna
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Primer contact check

Defined contacts can be checked individually or all at once...

- 64 bit (build 24451), Licensed to : DYNAmore Nordic

Pick CONTACT Pef Mesh tools
Composite | Load Path | Remove

FRIMER: M1: 190403, Troubleshooting example, acld insers with tied contact, IGS=2:Frep 2 Connection | Macra Rigidify
Cut sect [ Mass Prop | Safety
Explode Measure | Script
Find Mechanism| Text Edit
i Groups Mode Impart | Units

y ICFD Setup | Orient Wol Calc
Include Other ¥| Hrefs
wolumes | & I wolume Il
v|DATABS  ¢| INITIAL PERTURE

i
DEFINE  ¢[INTEGRMN  ¢| RAIL
DEF_2_RG [INTRFCE  p|RIGIDWSLL

i

¥

i

P1 @ Load digtfibuting device

CASE ELEMENT ¢[LOAD SECTION
COMMENT |EQS MAT SEMSOR
COMETRE. S EATIGUE  p|MODE SET
CONTACT | FREQ, ¥| PARAM TERMIN
COMTROL | HOURGL PART ¥
DAMPING | INCLUDE ¢| PARTICLE

M1:Main file

COMTACT

Creale Delete List

Copy Keyword Check— 0y
Modify Renumber Help
Friction

S_PTI 11 tilternal contact cal)

Tl i
{MiL) CONTACT(9) {all models)
SR NT-Ciea-pantart el plateto-frome TED_BHELL_EDEETE_BURFACEY
W1 /CONTT 9000001 {Fusher to Cab  AUTOMATIC_SURFACE_TU_SLIRFACE)
NG N ODEEBE- it rontart - HEB_BHEEE_CD GE_TO_BORFAEEY

M1/CONT1S000111 (Cah internal contact | AUTOMATIC_SINGLE_SURFACE)

)

B Contact chacker has been dismissed - data for plot lost Nods piot | Li 51

T reclraw the contact check plat you wil nesd o rerun
i the checker. Reverting to shadsd mode platting for now
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Primer contact check

...and visualized in different ways.

- 64 bit (build 24451), Licensed to : DYNAmore Nordic

Pick CONTACT P WMesh tools

Composite | Load Path | Remove
FRIMER: M1: 190403, Traubleshooting example, 2cd insers with tied contact IG8=2:Prep 2 PENETRATION o —] v Rigidity
Cut sect [ Mass Prop | Safety
Explode Measure | Script
Find Mechanism| Text Edit
Groups Mode Impart | Units
ICFD Setup | Orient Wol Calc
Include Other ¥| Hrefs

Wiolumes | & || “iolume: 111
7| DATABS  p| INITIAL r| PERTURE
DEFINE  ¢[INTEGRMN  ¢| RAIL
DEF_2_RG [INTRFCE  p|RIGIDWSLL
i
¥
i

CASE ELEMENT ,|LDAD SECTION
COMMENT [EOS MAT SENSOR
CONSTR _y|FATIGUE ¢|NODE SET
CONTACT [FREG. o[PARAM TERMIN
BT FERNEE CONTROL #|HOURGL _ [PART ¥
DAMPING y|INCLUDE ,[PARTICLE

Dismizs Check all Options...

List Info Check visihle Only

COMTACT

Creale Delete List
Copy Keyword Check
Modify Renumber
Friction

K e

Fen: 973 vis 973 total

o crossed edges
Min: 3 35838-02

Seftings... Max: 5.00008-01

Surm: 4 B770e+02

[ —

B To Feclrasw the contact chack plot you will nesd to rerun
Btr-c checker. Reverting to shatied mods piotting for now
| Contact chieck (k1 :C18000001 ) Caleulation complete
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Selection of Primer model checker features

Pre-analysis checking, e.g.
Contour plot of Density, Yield stress, Poisson’s ratio, Young’s modulus and Material number
(e.g. 20 for *MAT_RIGID).

Checks can be switched on, e.g.
Check for large CNRBs.
Distance between volumes that make up one rigid body is too large.
Duplicated elements, elements that share nodes and part definition.

Using “attached” recursively can help to find unattached things in the model.
Do not perform model check on, or limit to, selected includes.

Visualization of friction coefficients between entities.

Ability to set LS-DYNA version that model will be run with.

Checking during the analysis
Read LS-DYNA output files and highlight selected entities (see next slide).

Post-analysis checking

Using REPORTER: Automatically create a report showing an energy balance plot, added
mass, etc. with a script.
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Highlighting from output data

PRIMER 16.0 - 64 bit (build 24451), Licensed to : DYNAmore Nordic

I=# R Kepwords Tools Disply Images Wiewing

PRIMER: M1

Optiors

Help Biank

3

PART (any type) T | Keyine

[FPIET | Undo

Dy outputfres viewsr

->item mode | list

Sketch | Blank | Unblank | only

show files

[CJERROR [0]
CIWARNING [5]
CITERMINATION [0]
OTIMESTERS [1]

ElSmallest Timesteps [2500]

102225
174600
174600
181017
181017

100002 5.5265E-07
100008 6 5043E-07 (mes0015)
100006 6.5043E-07
100008 6 5043E-07 (mes0017)
100006 6.5043E-07 (d3hsp)

d3hsp)

(
{
(d3hsp)
{
(

ermination

3

Ticy |
EREAEEEEEE < | v | > |

e
+ ¥ A|l¥|F

ER
v [ |

Read Dyna autput ‘

Dyna file directory: [gh " L

Anlitional search:

Compressed search J

Output files found:
’7 Select/Deselect all

i W dahsp

A [ mesoooo
[\ mesnaon
W mesonnz
W/ meson0
[/ mesnona
[ mesnoos
[ mesnone
W mesono7

. [u# mesonog
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Did you know...?

Both LS-PrePost and Primer can load two versions of the same model and

highlight differences.

5 LS-PrePost(R) V4.8 (Beta) - 06Apr2020(15:10)-64bit sk/work/davida/d3hsp_viewer/ROPS/Error model/error model.key

File Misc. View Geometry FEM Application Settings Help

. 190403, Troubleshooting example, add insers with tied contact,IGS=2:Prep 2

(7] Assembly 1
7] FEM Parts

Keyvrord Entity
Boundary

Ll

Contact
Define
Set

- Model Compare LoaE3 B Model Selection
| 4. summanginfr Common Keywords |Model1 only,| el O eyl
} BOUNDARY LT 1-190403, Troubleshooting example, add in
» CONTACT - . 2-190403, Troubleshooting example, add i
Keyword count: 1

> CONTROL
ACCURACY(1, Keyword IDrange: 12 To 12
BULK_VISCO® Field #1 Field #2 Field #3 Field #4 Field #5|Field #6 Field #7|Field #8|Field #9 - () Keyword
Card #0 [SLSFAC  RWPNAL |ISLCHK | SHITHK PENOPT |THKCHG ORIEN  ENMASS -

D

ENERGY(L,:1) Value 1 0.100000 0.0 2 0 0 1 0 0
HOURGLASS( - - 1st Model 2nd Model
IMPLICIT AUT Value 2 0.100000 0.0 2 0 0 1 0 0 ) )
IMPLICIT_DYN )
IMPLICIT_GEN Card #1 USRSTR USRFRC NSBCS |INTERM XPENE |SSTHK ECDT  TIEDPR| Compare
IMPLICIT_SOL et 0 0 0 0 0.0 -0 0
MPP_IO_NODI prm— 3 FS 5 50 -0 0 Type: | Stress -
OUTPUT(1, 1) - -
SHELL(1, 1) Componets Name:
souD(1, 1) Card #2 |SFRIC  |DFRIC  [EDC VFC TH TH_SF  PEN_SF x-stress I
SOLUTION(1, Value 1 0.0 0.0 0.0 0.0 0.0 0.0 0.0 y-strees
TERMINATION value 2 0.0 0.0 0.0 0.0 0.0 0.0 0.0 R

» DATABASE BEs v

» DEFINE [ Viewall Draw | Keyword 1 || Keyword 2 Fringe Diff

i WriteSummary || WriteDetail Done Done
g

w8

i

< F

@
& WO EF

¥KHOU O[OS E@

Woal -

L #0900 0H 8% @S-

>

9w @

P
&

EEOe@ - X wal's

T e
kwdecmp compare 1 2
Model Selection

Fast Renderer
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Did you know...?

In LS-PrePost, prescribed rigid body motions can be visualised before the
simulation.

5:10)-64bit sk/work/davida/d3hsp_viewer/ROPS/Error_model/error_model_6.k

3

ntact,IGS=2:Prep 2 2

@ Vv

5 &

4 S

, Sl -
3 Entity Display | B2 B

Entity Display = Entity Preview v 6@

Type: =4

:

P

H

&

Preview items:

% Boundary Prescribed

|| Boundary Prescribed

¥HOCO[OE %@l

Next || Boundary Prescribed
|| Boundary Prescribed
|| Boundary Prescribed
S —
.
Clear \
=
) . ®o
> E
x
Done
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Potential errors not captured by model checkers

Have you used consistent units throughout your model?

Are the shell thicknesses correct?

Are the material directions correct?

Are the orthotropic friction directions correct?

Are the connections correct? Beams and shells connected to solids?

Perform a visual inspection of your results.
Realistic deformation?
Contact releases or malfunctions?
Realistic plastic strains?

Visualize in
preprocessor.

Is the applied modelling technique a good representation of the real physics?
Are your rigid bodies really rigid?
Do your boundary conditions affect the results?
Are your material models calibrated and valid?
Is the applied friction feasible?
Mesh convergence?

Inappropriate control card settings. Remedy: Read DYNAmore guidelines.
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._
Summary

Follow modelling guidelines, either your own or DYNAmore Nordic provided
recommendations.

Run some form om checks before simulation of your model.
Manually using your preferred softwares.
In batch mode (Ansa, Primer, using scripts, etc.).

Consider all Warning messages given in the output files.
In post-processing, check for mass increase and energy balance.
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Further reading

https://www.dynalook.com/conferences/15th-international-ls-dyna-
conference/modeling/getting-your-model-2018right2019-2013-checking-
before-during-and-after-your-ls-dyna-r-analysis/view

(Primer conference paper)

Primer checking tutorial: https://www.youtube.com/watch?v=4pSrz9cAdbY
2020-02-18 DYNAmore Nordic Webinar:

Jointing techniques between shell and solid elements

2020-02-25 DYNAmore Nordic Webinar:
Troubleshooting convergence problems in LS-DYNA implicit
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https://www.dynalook.com/conferences/15th-international-ls-dyna-conference/modeling/getting-your-model-2018right2019-2013-checking-before-during-and-after-your-ls-dyna-r-analysis/view
https://www.youtube.com/watch?v=4pSrz9cAdbY

Thank you!

more
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